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Algilez 
International Language 

 

 

 

The Algilez Alphabet and font 
This guide explains the reasons for and the details of the Algilez Alphabet and font. 

 Œ 
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1  Start Here - Downloading the Algilez Font 
1.1 Downloading the font 

In order to see text using Algilez Alphabet characters, it is necessary to download the Algilez Font Algilez True 

Type Font (32KB).  Use the right mouse button (not the left) and 'Save Target as ...' (MS Internet Explorer) or 'Save 

Link as ...' (Firefox) will enable you to copy the file onto your computer prior to installing.  (Clicking with the left 

button only gives a preview of the font and does not enable you to download and install it). 

Save the font file into any convenient folder on your computer. 

1.2 Installing the font 

This is a True Type font and can be installed very easily through: 

'My Computer > Control Panel (Classic View)> Fonts > File > Install New Font'. 

Find the folder containing the font file and it will appear in the box. 

1.3 Kerning 

In order to give the best appearance to the font, it is necessary to make sure that kerning (automatic letter spacing) 

is turned on.  This can be done for each style type by: 

1. Format>Style>Modify> 

file:///C:/Users/Alan/Alan%20Folders/Gilo%20&%20other%20language%20(L)/Algilez/Algilez%20Changes%20to%20Keyboard.docx
file:///C:/Users/Alan/Alan%20Folders/Gilo%20&%20other%20language%20(L)/Algilez/Algilez%20Changes%20to%20Keyboard.docx
file:///C:/Users/Alan/Alan%20Folders/Gilo%20&%20other%20language%20(L)/Algilez%20Expression%2002/Gilo15.ttf
file:///C:/Users/Alan/Alan%20Folders/Gilo%20&%20other%20language%20(L)/Algilez%20Expression%2002/Gilo15.ttf
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(For Word 2003 go direct to 2) 

2. Format>Font>Character Spacing>Kerning for fonts (check)>OK>OK>Apply' 

 

 

2  The Algilez Alphabet 

The alphabet is made up of symbols from a basic 'cartwheel' sign. Œ 

0 1 2 3 4 5 6 7 8 9 

0 1 2 3 4 5 6 7 8 9 

za an du tri før fãv sis sev ok nin 

 

ã ø a b c d e f g h i j k l 

ã ø a b c d e f g h i j k l 

a(r) o(r) a be ce de e fe ge he i je ke le 

 

 

m n o p q r s t u v w x y z 

m n o p q r s t u v w x y z 

me ne o pe qe re se te u ve we xe ye ze 

 

Algilez 

Symbol 

Upper 

Case 
Symbol Pronunciation 

Lower 

Case 

Upper 

Case 

ã Ã Symbol pronounced 'a(r)' (as in far) ã Ã 

ø Ø Symbol pronounced 'o(r)' (as in fort) ø Ø 

a A Symbol pronounced 'a' (as in cat) a A 

b B Symbol pronounced 'be' (as in bed) b B 

c C Symbol pronounced 'che' (as in cheddar) c C 

d D Symbol pronounced 'de' (as in den) d D 
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e E Symbol pronounced 'e' (as in bet) e E 

f F Symbol pronounced 'fe' (as in fen) f F 

g G Symbol pronounced 'ge' (as in get) g G 

h H Symbol pronounced 'he' (as in hem) h H 

i I Symbol pronounced 'ee' (as in beet) i I 

j J Symbol pronounced 'je' (as in jet) j J 

k K Symbol pronounced 'ke' (as in kettle) 

Also serves as initial question mark (?) 
k K 

l L Symbol pronounced 'le' (as in let) l L 

m M Symbol pronounced 'me' (as in met) 

Also the word for ' I ' or 'me' 
m M 

n N Symbol pronounced 'ne' (as in net) 

Also the word for 'no'. 
n N 

o O Symbol pronounced 'o' (as in hot) o O 

p P Symbol pronounced 'pe' (as in pet) p P 

q Q Symbol pronounced 'the' (as in thesaurus) q Q 

r R Symbol pronounced 're' (as in red) r R 

s S Symbol pronounced 'se' (as in set) s S 

t T Symbol pronounced 'te' (as in ten) t T 

u U Symbol pronounced 'oo' (as in chute) u U 

v V Symbol pronounced 've' (as in vet) v V 

w W Symbol pronounced 'we' (as in wet) 

Also the word for 'and' or '&'. 
w W 

x X Symbol pronounced 'she' (as in shed) x X 

y Y Symbol pronounced 'ye' (as in yet) 

Also the word for 'yes'. 
y Y 

z Z Symbol pronounced 'ze' (as in zebra) z Z 

2.1 New sounds and new letters 

Three of the normal Roman alphabet letters are given their own consonant sounds.  'c' is pronounced 'ch' (as in 

cheese), 'q' is pronounced 'the' (as in thesaurus) and 'x' is pronounced 'she' (as in shed). 
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Two new vowels are added to the Roman alphabet.  The first vowel is ã a(r) pronounced as in far.  The second is ø 

o(r) pronounced as in fort.  All characters in the Algilez alphabet are made from components of the original 

cartwheel pattern. 

 

Although the use of additional letters with diacritical marks is not desirable (it caused considerable problems with 

Esperanto), much of the problem was due to typesetting and conventional typing restrictions.  With modern 

computer fonts the issue can be easily resolved.  As for the need for the two extra vowels, the English language 

actually has 31 different pronunciations of the 5 vowels, so I don’t think asking people to learn an extra two vowels 

(instead of an extra 26) is too much. 

 

The English Language keyboard layout will need to be modified to produce these two new characters more easily 

(i.e. with just two keys instead of 3 or 4), which only takes a few seconds and should not affect your normal use of 

the keyboard.  Please go to this link to see the instructions:- Changing keyboards to type ã and ø characters 

 

3  Writing & Printing Algilez 
 

Algilez is written along a theoretical centre line through the 'hub' of each symbol. 

 

The cartwheel, with its 16 basic components (i.e. 8 arms and 8 arcs) can form many hundreds of symbols, although 

only about 50 are required for normal use (i.e. alphabet letters, numbers, mathematical and punctuation symbols). 

 

Hand-written symbols will still need to written reasonably carefully to maintain legibility.  There would be an 

advantage for people to learn the pen strokes in a more formalised way, in order to standardise the handwriting (in 

a similar way that Chinese & Japanese children are taught the correct order in which the pen strokes for the Kanji 

characters are to be made).  E.g. 

 

 

4  Upper & Lower Case, Punctuation 
 

In Algilez there are no different upper or lower case letters.  Initial letters of sentences, proper names and initials 

(such as UN etc) have the 'za' circle around them, which then forms the equivalent of upper case e.g. :- 

 

Algilez:-  Algilez 

John Smith:-  Jon Smiq 

UN   UN 

 

file:///C:/Users/Alan/Alan%20Folders/Gilo%20&%20other%20language%20(L)/Algilez/Changing%20keyboards%20to%20type%20ã%20and%20ø%20characters.docx
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Full stops (periods) come at the end of a sentence but always on the centre line. 

A conventional one letter space gap is used between words, after full stops (periods) and between number parts. 

A right comma (font symbol 44) is used between phrases and parts of a number. 

 

5  Additional Algilez Symbols 

Mathematical Symbols 
 

Symbol 

Number 

* om, omez Symbol for multiply (times x or *). 42 

/ at, atez Symbol for divide (divided by, ÷ or  /). 47 

- lu, luez Symbol for subtract (minus -). 45 

+ wu, wuez Symbol for addition (plus +). 43 

= ek, ekez Symbol for equals (=) 61 

Grammatical & 

Punctuation Symbols  
Symbol Number 

( lefus Symbol for left bracket 40 

) retus Symbol for right bracket 41 

" pous Symbol for quoted speech mark 34 

“ gipo 
Symbol for beginning of quoted 

speech mark 
147 

” finpo 
Symbol for end of quoted speech 

mark 
148 

. fin 
Symbol for end of sentence mark 

(full stop/period) 
46 

, lãlpo Symbol for pause, comma 44 

0 alus 
Symbol for capital/initial letter 

(same as 'za', zero symbol) 
48 

Other symbols are shown below with the equivalent Roman alphabet or keyboard symbol underneath. 

  ( ) { } [ ] , . / \ ¬ 

 
( ) { } [ ] , . / \ ¬ 

 
* £ $ + - = _ 

    
 

* £ $ + - = _ 
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6  International Phonetic Alphabet (IPA) 
 

IPA characters are a peculiar set of modified Roman and other characters e.g.:- ,. , , , ,  

 

These are virtually unknown outside language teaching.  However they are the only simple way of expressing the 

majority of sounds used in different languages.  The three Phonetic Alphabet ‘N’ symbols used above, are obvious 

variations on the letter ‘N’. 

However, things become much more difficult with characters such as , & especially .  Here the 

relationship to normal Roman alphabet letters is less clear and no-one apart from a language expert will know what 

sounds the symbols represent. 

 

There are many unused Algilez symbols available to incorporate all of the main International Phonetic Alphabet 

and other associated characters. Where the IPA character has a similar (but slightly different) sound to a Algilez 

character, then by the addition of parts of the perimeter arc to the Algilez symbol it is possible to form a new symbol 

and demonstrate its linkage and similarity. 

E.g.  the Algilez character for 'n' is n. 

The nasal 'ng', which is shown by the Phonetic Alphabet character , can be Character 192 in Algilez – À. 

Other similar 'n' sounds, such as  and  can be shown by similar characters e.g. Á (193) and Â (194). 

Similar modifications could be made to the Algilez letters u, ã & c which are similar to , & . 

Even the simplest Algilez letter u (the ‘oo’ sound) could have up to six additional arc parts added (top left, top right, 

top left & right, bottom left, bottom right, bottom left & right) to denote similar but slightly different sounds in other 

languages. 

 

There are several implications for this.  It could mean that languages presently using the Roman alphabet could be 

written using a particular subset of the full, international Algilez alphabet (i.e. one incorporating all of the sounds in 

the International Phonetic Alphabet).  This would avoid the confusing idiosyncrasies presently found in many 

languages due to pronunciations of words being quite different to their spellings (particularly in languages such as 

English and French). It could make the learning of other second languages much easier since students would see 

the Algilez phonetic symbol and be able to see the similarity to other Algilez characters from which the sound has 

originated and what the correct pronunciation should be. 

 

However we have to bear in mind that word recognition may depend as much on spelling (no matter how 

idiosyncratic) and that national culture may require the retention of what might not be totally logical spelling 

systems!  It would obviously be counter-productive if an aid to learning then had to be ‘unlearnt’. 



Algilez International Language – Alphabet & Font 27 August 2009 

 

Page 7 of 8 

 

7  The Algilez Font 
 

The Algilez font has been created as a True Type font using a proprietary font writing programme 'TypeTool' from 

the Fontlab Company.  The Algilez version used in this text is version 1.5.  A number of additional symbols are still 

required.  These will be created in the near future. 

 

An example is the Algilez letter 'ke'.  In its simplest form is just k or K . 

The font currently used is designed to be as simple as possible and is probably best compared to a Algilez version 

of Ariel. 

However, we can also create letters such as Ê , or Ä or even more elaborate styles such as Å which are still 

perfectly clear Algilez characters. 

 

In other words, the Algilez alphabet is capable of being represented in a complete range of different fonts.  It would 

therefore be possible to have the Algilez equivalents of fonts used for the existing Roman alphabet such as  

Comic, Old English, Times New Roman, etc. 

 

8  What is wrong with the Roman Alphabet? 
 

There are two main problems.  One is that it is already too complicated, with upper case, lower case and 

handwritten letters which may differ.  The second, more important problem, is that the sounds of the letters in the 

Roman alphabet differ between different languages and even within a single language.  For example in English, the 

Concise Oxford Dictionary gives :- 

 7 different pronunciations of the letter 'a' 

 6 different pronunciations of the letter 'e' 

 4 different pronunciations of the letter 'i' 

 10 different pronunciations of the letter 'o' 

 4 different pronunciations of the letter 'u' 

all differing according to the context, preceding and following letters and historical usage.  If you compare the 

pronunciations of Roman letters in some of the major European languages e.g. English, German, French, Italian 

and Spanish, they all differ!  There is not a single Roman letter which has a constant pronunciation throughout 

these languages! 

There are probably only four Roman letters that could be considered as having a 'standard' pronunciation by the 

majority of languages: - d, k, m & p. 
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Hence, although there is a workload involved in the learning of a new alphabet, the time taken would be rapidly 

repaid by the elimination of the confusion resulting from the multiple sounds possible for conventional Roman 

letters. 


